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Product Overview
OnWeb Web-to-Host is a server-based Web application that publishes your existing legacy applications in
intranet, extranet, and Internet environments. It includes host display, printer, and file transfer features that
enable end users to work productively with host-based information in a familiar Windows or Web browser
environment. Web-to-Host provides access to a broad range of host types, including IBM mainframe, IBM
AS/400, DIGITAL VAX, UNIX, and HP systems.

System administrators can use the Session Configuration Manager tool to easily configure client sessions
that can be published to end users.

Features
Designed for use in an intranet environment, the Pro component offers a rich feature set and consists of
ActiveX controls that give users access to mission-critical host applications and data. Pro provides these
client session types:

• Mainframe Display, Mainframe Printer
• AS/400 Display, AS/400 Printer, AS/400 File Transfer
• UNIX Display
• HP Display

Pro client sessions include these advanced features and options:

• Mainframe file transfer (can include SimXfer tables)
• AS/400 file transfer
• AS/400 batch file transfers
• Macros
• Hotspots
• User profile enhancements
• Restricted user support
• An MSI packaging utility for automatically installing Pro components
• A distribution utility
• A download and install service
• VBA-type scripting
• Customizable menus and toolbars
• End-user keyboard mapping
• Administrator keyboard mapping
• Tracing

Hotspots, a word or set of characters on the host screen, activate a function when clicked. Using the
Hotspots Configuration dialog box, you can enable/disable, show/hide, create, and modify both default
and user-created hotspots. Default hotspots are host commands displayed on-screen. User created
hotspots are custom macros you assign to selected on-screen text. You can also use hotspots and macros
to log on to and run host applications automatically. Any protected text on your host screen can be turned
into a hotspot. In mainframe displays, you can also configure hotspots for non-protected text.

Pro AS/400 File Transfer moves files and data between the host and the PC using either the menu bar or
toolbar options of the AS/400 display. A customized toolbar button activates a pre-configured FTX file and
starts the AS/400 FTX application. A new AS/400 emulation type has been added to the Session
Configuration Manager. It opens the AS/400 FTX application and loads an existing FTX configuration on
the client. Your users can customize the file transfer session, configuring options such as the data format
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for sending and receiving, file locations, application behavior both during and upon completion of the
transfer, security settings, and host connection.

With enhanced user profiles, user configuration files (.cph) are no longer deleted automatically when
changes are made in the HTML files for configurable options. For more information, see User Profile
Configuration.

Pro ActiveX components are downloaded to the client once, during the first login. A new download service
is first installed on the client workstation. Once the service is installed on the client, all users (including
restricted users) can work with the Pro ActiveX controls. The service handles all installs, upgrades, and
downloads of Pro ActiveX components.

The Web-to-Host Distribution Packager enables you to bundle multiple Web-to-Host configuration and data
files into a single, easily distributed package. Users can run sessions that include a complete work
environment with components such as pre-defined scripts, macros, hotspots, custom toolbars, background
images, icons, screen/font colors, AS/400 File Transfer and Batch File Transfer profiles. The Web-to-Host
Distribution Packager helps you provide standardized functionality and a single look and feel for all users.
For more information, see the online Help.

Architecture
The figure below shows how Web-to-Host works once the system administrator has created the host
sessions and published them to users. The following sections describe how this architecture is applied to
each of the component types.

The ActiveX objects are downloaded to the client the first time a user opens a session. When you install
updates on the server, they are downloaded automatically to the client the next time a user opens a
session. This architecture enables the client to communicate directly with the host, as shown in the figure
above.
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Security
Web-to-Host maintains persistent client-to-host sessions. It is important that users be aware of session
persistence in relation to information security, especially when sessions are configured to run inside a
browser window. In this mode, only one session is visible on the screen at a time, though other sessions
could be running in the background.

Users who have access to sensitive information on host systems should consider running each session in
a separate window to keep all concurrent sessions visible on the screen. Users can also ensure that all
connections are severed by closing their browser when they leave their work area. For details on
configuring sessions to run in a separate window, see Start options.

Web-to-Host supports:

• SSL (Secure Socket Layer) for IBM mainframe, AS/400, and UNIX hosts.
• SSH (Secure Shell) for Pro UNIX display.
• Kerberos authentication for AS/400.

With this security support, users can securely access applications and transfer data between their
desktops and mainframe, AS/400, and UNIX systems, encrypting the session data stream to a host
capable of supporting these protocols.

Finding information
Web-to-Host product documentation includes:

• This Administrator Guide, which explains how to install, uninstall, configure, and deploy the product.
• The Readme file, which contains information about new features, late-breaking changes, and known

issues.

The Help page of the Session Configuration Manager contains links to the Readme file and this
Administrator Guide.

• Context-sensitive Help for the Session Configuration Manager, a tool for configuring Pro client sessions.

• User guide for Pro client. This Help for end users explains how to configure and run features and
options in the client session.
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Server Installation
Installing Web-to-Host Server on a Windows platform

Note: Web-to-Host Server can be deployed only on a 64-bit Windows platform.

1. Either activate Internet Information Server (IIS), or install any other Web Server.
2. Install Web-to-Host Server under the root directory of an installed Web server.
3. Run the Session Configuration Manager to create and configure (or migrate) session profiles.
4. Publish session profiles to clients.

Web-to-Host files are installed in a w2hlegacy directory (created during installation) that must reside
under the root, or in the subfolder of the root directory of the installed Web server.

Installing Web-to-Host Server on a non-Windows platform

1. Install Web-to-Host Server to any place on any machine. Web-to-Host files are installed in a
w2hlegacy directory (created during installation).

2. Install or run a Web server on the target non-Windows platform.
3. Copy the w2hlegacy directory to any location under the root directory of the Web server running on

the target non-Windows platform.
4. Run the Session Configuration Manager to create and configure (or migrate) session profiles.
5. Publish session profiles to clients.

Installing
Web-to-Host Server setup exists in four variants, shown below in increasing features set order:

Web-to-HostSetup.msi - standard setup.

Web-to-HostSetup-RDE.msi - RDE-enabled setup.

Web-to-HostSetup-Citrix.msi - Citrix-enabled setup.

Web-to-HostSetup-Eval.msi - fully featured 30 day evaluation setup.

Installing on a Web server running Windows

Using Setup

1. Run one of the appropriate MSIs listed above. 

This installs a default instance of Web-to-Host Server (see the next section about installing multiple
instances).

2. Click Next in the Welcome dialog.

3. Read the End-User License Agreement, select the option to accept it, then click Next.

4. Specify the Web Server Root directory (this can be the root publishing directory of your Web server or
any subdirectory under the Web root), then click OK.

5. To install to a subdirectory, select Enable subdirectory support, then type the path in the box
provided.

6. The setup program creates a new w2hlegacy directory in either the specified Web Server Root
directory or in its subfolder, which is specified by the path under Enable subdirectory support.
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7. When setup finishes, click Finish button to exit.

Using the command line
Web-to-Host Server Setup allows you to install up to five instances side-by-side using command line
options in addition to the default instance. In addition, for any instance of Web-to-Host Server, both the
Web Root directory and Web Root subdirectory can be specified on the command line.

Installing a default instance

To install a default instance, run the following command. Square brackets [ ] enclose optional attributes and
angle brackets <> enclose parameter values.

msiexec /i <full_path_to_msi> [INSTALLDIR=<Web_Root_directory_path>]
[ENABLE_WEB_SUBDIR=1 WEB_SUBDIR=<Web_Root_directory_path>]

Values containing spaces must be enclosed in quotation marks ("). For example:

INSTALLDIR="C:\Program Files\wwwroot"

Example:

msiexec /i C:\temp\Web-to-HostSetup.msi INSTALLDIR=C:\inetpub\wwwroot
ENABLE_WEB_SUBDIR=1 WEB_SUBDIR=w2hServer

Installing a non-default instance

You can use the Web-to-Host Server Setup multi-instance functionality to install up to five instances of the
same Web-to-Host Server version on the same machine.

The difference between the instances is up to you. For example, you might want different fixes to be
applied to different instances, or you might want to install particular instances outside the Web Root
directory as templates to be used later on a variety of other operating systems on other machines.

To install a non-default instance, two mandatory command line options are necessary in addition to the
optional ones on the command line above. The pipe sign ( | ) denotes mutually exclusive values:

msiexec /i <full_path_to_msi> MSINEWINSTANCE=1 TRANSFORMS=":_<1|2|3|4|5>"
[INSTALLDIR=<Web_Root_directory_path>] [ENABLE_WEB_SUBDIR=1
WEB_SUBDIR=<Web_Root_directory_path>]

Here, TRANSFORMS must have one of the values ":_1", ":_2" and so on, which can be arbitrarily picked
from the five values allowed.

Values containing spaces must be enclosed in quotation marks ("). For example:

WEB_SUBDIR="w2h Server"

Example:

msiexec /i C:\temp\Web-to-HostSetup.msi MSINEWINSTANCE=1 TRANSFORMS=":_5"
INSTALLDIR=C:\inetpub\wwwroot ENABLE_WEB_SUBDIR=1 WEB_SUBDIR="w2h Server"

Any attempt to install the same instance twice would cause an error message.

Installing by copying
1. According to the instructions in the sections above, install a Web-to-Host Server instance - default or

otherwise - in the instance parent folder on a Windows machine, regardless of the Web server on that
machine.

2. Install and activate a Web server on the target machine, which can run any operating system - Windows
or otherwise.

3. On the target machine, prepare the Web-to-Host Server location. 
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If you decide to set up Web-to-Host Server in the Web Root subdirectory, create the subdirectory.

4. Copy the w2hlegacy folder from the instance parent folder on the Windows machine to the Web-to-
Host Server location on the target machine.

Session Configuration Manager
After installing Web-to-Host on your Web server, the next task is to use the Session Configuration Manager
to create, edit, and migrate client profiles.

1. To run the Session Configuration Manager for Web-to-Host Server instance, which is installed by
running a .msi file, from the Windows Start menu, select All Programs > Micro Focus > Micro
Focus OnWeb 6.9.4.

2. To run the Session Configuration Manager for the Web-to-Host Server instance installed by copying,
navigate to the following address with your browser: http://<Web-to-Host-Server-location>/w2hlegacy/
config/hostwizard. 

For example:

http://localhost/w2h6.9.4/w2hlegacy/config/hostwizard/

Uninstalling
When removing Web-to-Host Server, you should also uninstall the Web-to-Host Pro Client from any client
machines it might have been installed on. See Client uninstall.

Uninstalling Web-to-Host Server instance installed
by .msi
1. Select Control Panel > Programs and Features.
2. Select Micro Focus OnWeb Web-to-Host Server 6.9.4 SP2, then click Uninstall.

Uninstalling Web-to-Host Server instance installed by
copying
Remove the w2hlegacy folder from the Web-to-Host Server location on the target machine
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Creating and Migrating Client Profiles
After installing Web-to-Host on your Web server, the next task is to create or migrate client profiles. You
may also want to edit client profiles to configure new options, such as security, distribution packages, Pro
toolbars and menus, and Pro watermarks.

This chapter explains how to use the Session Configuration Manager to create, edit, and migrate client
profiles and how to deploy client profiles to your users.

Migrating client profiles from a previous version
After updating Web-to-Host by installing a new version or upgrade, you must migrate all session profiles
created in the previous version by running the Session Configuration Manager in server mode. If you do
not update the session profiles, Pro client sessions do not open. An error message appears, prompting you
to contact your system administrator.

For details on running the Session Configuration Manager in server mode, see Creating client profiles.

Migrating profiles after upgrading
1. Run the Session Configuration Manager on the server by typing the following in the address bar of your

browser: 

http://<webserver_name>/<subdirectory>/w2hlegacy/config/hostwizard

2. Click the Convert tab.

3. Load sessions by clicking Load Session.

4. Click Convert.

This ensures that your Web-to-Host installation incorporates the most recent version numbers in the
session HTML files. Once new software is downloaded to the client workstations, the version numbers on
client workstations and session files must match. If new parameters exist in the current product version that
were not defined in the migrated profile, Web-to-Host uses the default values.

When the user opens a migrated profile, the browser displays a standard security dialog box asking if the
user wants to install and run software from Rocket Software. Administrators should tell their users to click
Yes.

Running the Conversion Utility
1. Click the Convert tab.

2. Click Load Sessions to load Web-to-Host HTML sessions from previous versions.

3. Click Convert. 

A result is shown for each file. If the conversion is successful, the converted file is added to a .zip file
which is downloaded to your computer.

4. At the end of the conversion process, a .zip file containing the converted sessions will be downloaded
to your computer.
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Creating client profiles
This section describes how to use the Session Configuration Manager to create a new Web-to-Host client
session for your users. The Session Configuration Manager utility saves your client configuration settings in
an HTML file that invokes a named Web-to-Host client session.

To run the Session Configuration Manager for Web-to-Host Server instance installed by running a .msi,
from the Windows Start menu, select All Programs > Micro Focus > Micro Focus OnWeb 6.9.4.

To run the Session Configuration Manager for a Web-to-Host Server instance installed by copying, navigate
to the following address with your browser: http://<Web-to-Host-Server-location>/w2hlegacy/config/
hostwizard.

For example:

http://localhost/w2h6.9.4/w2hlegacy/config/hostwizard/

Creating or editing a client profile
To use the Session Configuration Manager to create or edit client profiles:

1. Run the Session Configuration Manager on the server or on your local workstation.

2. Optional: For general instructions on using the Session Configuration Manager, click the Help icon at
the top right of the screen. This menu also contains links to the Readme file and this Administrator
Guide.

3. Click the Create tab, then do one of the following as needed:

• Create a new session. Select the session type, then click Create.
• Edit an existing session. Under Open an Existing Session, click Open, then specify the full path of

the HTML session configuration file to edit. The Browse utility defaults to the location of the last
saved configuration file.

The tabs for the selected host type appear.

4. Optional: Click each tab, click ? at each section, then print the help pages for each tab.

5. Configure the settings on each page as needed:

• For details on each field, see the online help. For details on configuring client start options,
concurrent sessions, and multiple language support, see Configuring client profiles.

• The Session Configuration Manager displays an asterisk next to required settings, and provides
many default settings. You need to enter only a few unique settings to make your connections work
correctly. However, you should check each page to be sure you select the appropriate options for
your needs.

6. To save the profile, click Create at the bottom of the Session Configuration Manager. 

Web-to-Host generates the HTML file and instructs the browser to download the file to your computer.

The browser prompts you for the download location.

7. Specify an appropriate folder in which to save the profile. 

You must save the profile in a Web-published folder. Otherwise, client sessions do not receive automatic
updates from the Web server.
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Configuring client profiles
This section describes some of the common options you can configure when creating or editing client
profiles in the Session Configuration Manager. For a list of options related to each technology, see the
Session Configuration Manager Help .

Start options
The following options are located on the Session Options page when creating or editing client profiles in
the Session Configuration Manager:

Run in a Separate Window

This option applies to Pro display profiles.

The Run in a Separate Window option opens the client session in a separate browser
window.

You can also use this option to configure a Pro display profile to launch multiple standalone
sessions using the same configured connection. For details, see Multiple sessions.

The default is Clear. The host session runs inside the browser.

Server URL
With this option, you have the ability to run sessions from a web server other than the
default Web-to-Host server. The URL you enter indicates the location of the alternate Web-
to-Host server.

Enable Local Start

This option allows users to run host sessions when the web server is unavailable. With this
option, whenever the user opens a client profile stored on the web server, Web-to-Host
copies that profile to the client workstation. The profile resides on the web server as an
HTML file that is named after the client session:

%LOCALAPPDATA%\Micro Focus\Rumba\LocalStart

It is best to run client profiles from the server to ensure that users have the most up-to-date
configuration and software.

When running local start profiles, help files are only available if, during configuration, the
administrator selected Install User Guide locally. Auto macro files and keyboard map files
configured by the administrator are cached on the client workstation when the session is
downloaded from the server, so these local copies are accessible to the client session
when the originating server is down. By default, the Enable Local Start option is not
selected.

Multiple sessions
Users can run concurrent Web-to-Host sessions and switch between session windows to perform tasks.
How users initiate multiple sessions and navigate between them depends on how you configure the
session profiles. There are three scenarios:

• Multiple sessions running in separate browser windows

By default, users must open multiple instances of the browser to start multiple client sessions. Users
can run concurrent host sessions and switch between sessions by clicking each browser window in
turn.

• Multiple sessions running outside the browser
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Administrators can configure Pro display profiles to run in a separate window outside the browser (see 
Start options). The user must open a new instance of the browser to launch another host connection
but, once the new session is connected to the host, the browser can be closed without losing the
connection.

• Multiple Pro standalone sessions

Administrators can configure a Pro display profile to launch multiple standalone sessions using the
same configured connection. For example, a user can run two or more MyRumbaHost sessions, each in
its own window.

With this configuration, a new session opens in a separate window outside the browser whenever the
user accesses a session URL through the browser window. After launching one or more session
windows, users can close the browser without losing the host connection.

Configuring multiple Pro standalone sessions:

1. Create or edit or the Pro session profile in the Session Configuration Manager, then click the Session
Options tab.

2. Check Run in a Separate Window and Allow Multiple Standalone Sessions.

When you enable these two options, users can launch a new session window using any method that
requests the session URL. For example, if your Web site includes a Pro display session called
Display.html, users can open multiple sessions by:

• Clicking a link on a Web page

If the Web page includes a link to http://<yoursite>/Display.html, users can click this link to
launch a new session window.

• Refreshing the browser with the session URL listed in the address bar

When the browser’s address bar contains the session URL, users can click Refresh (or Reload) on the
browser toolbar to launch a new session.

• Typing the address in the address bar

If users have browsed to another location after opening the session, they can enter the session URL in
the address bar to launch another session window.

• Recalling the address from history

If users cannot remember the URL, they can open the browser’s history list, then select the session
URL to launch a new session window.

Users can switch between sessions by clicking each of the windows in turn or by using the taskbar. If the
browser closes, the session windows remain open.

International client sessions
When using the Session Configuration Manager to create or edit client profiles, configure the following
multi-lingual options to meet the language needs of your users:

You can set these options to use different languages if necessary. For example, you can set the user
interface to English and set the keyboard map and host character set to German.

Host Character Set
This option sets the host language (also known as the codepage). When configuring Pro and Java AS/400
and mainframe display or printer profiles, the option appears on the Connection page.

To specify the Host Character Set, select the language character set (or codepage) for the client session.
If the host uses a non-English (United States) language, select the language used by the host.

The host character set includes commonly used marks, accents, letters, and symbols of a specific
language. For example, if the host language is French, the host character set must also be French to
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ensure that French special characters are transmitted to the host correctly and that the characters received
from the host display in the client session correctly.

The default setting is English (United States) - 37.

Keyboard mapping options
These options set the country or custom keyboard map for Pro display sessions.

Web-to-Host supplies numerous country keyboard maps to accommodate the special characters and
symbols used in various languages. You can deploy country keyboard maps in several ways. For example,
you can:

• Standardize all the sessions on one country keyboard.
• Base the keyboard map on the client workstation's regional settings.
• Enable the user to specify their own keyboard mappings.

When using the Session Configuration Manager to configure Pro AS/400, mainframe, UNIX, and HP
display profiles, the following options appear on the Keyboard Map page:

Keyboard Map
You can select a standard country keyboard map or specify a custom keyboard map (.map
file) for the client session. For information on how to do this, see the Help. The default
keyboard map is U.S.A.

Custom Keyboard Map

The default is blank.

Note: To enable users to specify their own Pro keyboard map files, which
override the administrator-specified keyboard map, see the Session
Configuration Manager Help on the Client Options page when configuring
Pro display profiles.

Client Locale
This option sets the language of the Web-to-Host client user interface for display and printer sessions.

When using the Session Configuration Manager to create or edit any profile, this option appears on the
Client Options page.

For Pro sessions, the Client Locale specifies the language for the Web-to-Host client user interface, which
consists of the session window (including tool tips and the status bar), dialog and message boxes, error
messages, and Help.

The default value is English.

Multiple language scenarios
When running client sessions, users may need to view applications on an international host, require a
different country keyboard map, or require the Web-to-Host client user interface in another language. This
can be done by configuring the Host Character Set, Keyboard Mapping, and Client Locale options.

Different companies have different international language environments and require different display and/or
printer configurations. As such, it is impossible to provide a single procedure. This section lists possible
multi-language scenarios to help you determine how to best configure the options for your international
language environment.

In the following table, the first column lists the multi-lingual option, the second lists language scenarios, and
the third lists the suggested Web-to-Host settings.
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Note: There are multiple keyboard listings because Web-to-Host provides several keyboard mapping
options. For information on individual settings, see the Help associated with the page in the Session
Configuration Manager.

Option If Then

Host language The host uses a language (codepage) other
than English (United States).

In the Host Character Set option, select the
language of the host.

Keyboard All clients are localized on one language. In the Keyboard Map option, select the
country keyboard map or specify the full path
of the Custom Keyboard Map file.

Clients are localized on different languages
as indicated by different regional settings
(Control page) on the client workstations.

Select Use Client Regional Settings from
the Keyboard Map option

Keyboard Locale (default).

Each client uses the keyboard map based on
its regional settings.

Users need or want control over their own
keyboard maps.

Enable end-user keyboard mapping. User-
created keyboard maps override any country
keyboard map specified in the Keyboard
Map option.

Client user interface The client user interface uses a language
other than English and you want Web-to-Host
to use the same language.

Select the appropriate language from the
Client Locale option.

Note: Web-to-Host supports English,
French, and German.

The following are some other multi-language environments and suggested configurations:

• Clients connect to a host using the German language (codepage) and their regional settings are set to
German. In this scenario, you would set the client host character set, country keyboard map, and client
user interface language to German.

• Clients connect to a host using the English (United States) language (codepage), but their regional
settings are set to French (Canadian). In this scenario, you would set the client host character set to
English (United States), but the country keyboard map and client user interface language to French
(Canadian).

• Clients connect to a host using the English (United States) language (codepage), but some client
regional settings are set to French (Canadian) and others to German. In this scenario, you would want
to set the client host character set to English (United States), deploy a country keyboard map based on
the client regional settings, and set the language of the client user interface to either French or German.

• Clients connect to a host using the Spanish language (codepage) and their localization settings are set
to Spanish. In this scenario, you would set the Web-to-Host host character set and the country keyboard
map to Spanish. However, because Web-to-Host does not provide a Spanish client user interface, the
client user interface language must be set to English, French, or German.

Defining password level caching policy
Password level caching is involved with the AS/400 display or AS/400 file transfer.

On AS/400 hosts, password protection capabilities can be set to different levels, such as short or long
passwords. Client applications connecting to a AS/400 host must first query the password level set on the
host. This slows down overall system performance, increasing both connection time and network traffic.

To save time, Web-to-Host caches password-level data, by default. The first time the password level is
queried, the data is saved on the client PC. Afterwards, to avoid performance degradation, the cached
password level value is used for each connection.

Cached data is host specific. Once the password level has been cached for a particular host, it is used by
all sessions connecting to that host.
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The following changes should be performed on the Java Script parts of the HTML session configuration
files:

AS/400 Printer Pro Client

Comment out the old HostPwdLevel property setting.

AS/400 Display Pro Client

• Comment out the old HostPwdLevel property setting.
• Add the this.ResolvePwdLevelPolicy property setting to the stAS400DisplayProps()

function:

Property setting Description

this.ResolvePwdLevelPolicy = 0 Query and cache the password level value once and use it
from now on. Default value.

this.ResolvePwdLevelPolicy = 1 Always query and cache the password level value on each
connection.

this.ResolvePwdLevelPolicy = 2 Never query the host for the password level value and use
the lowest password level value on each connection.

Example:
function stAS400DisplayProps()
{
        this.SetMinFontSize = false;
        this.FontPointSize = 0;
        this.TypeAhead = true;
        this.AutoReset = false;
        this.StartupModelType = 2;
        // HostPwdLevel is now deprecated. It should be cleared from old 
sessions.
        //this.HostPwdLevel = false; 
        this.SuppressDialogs = false;
        this.ResolvePwdLevelPolicy = 2;     // (0=Once, 1=Always, 2=Never)
}

Publishing client profiles to users
You can use any usual Web publishing method to publish session profiles created by running the Session
Configuration Manager in server mode to users. For example, you can:

• Provide the URLs of the session profiles for users to enter in the address bar of their browsers.
• Create an HTML page containing links to the sessions and organize these links by host type or other

useful groupings.
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Web-to-Host Client Installation
This chapter describes procedures that users must follow when installing, updating, or removing Web-to-
Host files on the client workstation. If Rumba+ is also installed on the client workstation, users should
follow the procedures described in Coexistence: Pro and Rumba+ instead, to ensure successful
coexistence with Web-to-Host.

System requirements
This section describes the minimum system requirements and configurations required for client
workstations to run Web-to-Host components.

Client operating system
Web-to-Host supports these client operating systems:

• 64-bit Windows 10 and 11

Client browser
Web-to-Host supports:

• Google Chrome
• Internet Explorer 11
• Microsoft Edge
• Mozilla Firefox

Preparing to install the software
The following software needs to be installed on both client and server machines.

Server

• Web-to-Host Server

Client

Install the software in the following order:

1. .NET Framework 4.8 (if not already installed): Requires administrator rights.
2. NMServiceManager.msi taken from the server machine in \w2hlegacy\pro, if Google Chrome,

Microsoft Edge, or Mozilla Firefox are to be used. With Internet Explorer 11, this service is installed
when the first session is launched. Requires administrator rights.

Client install and upgrade
This section describes how users install and update Web-to-Host when the client does not also have
Rumba+ installed. Users must follow these procedures the first time they open a Web-to-Host session, and
repeat these procedures each time Web-to-Host is updated.
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Installing Pro
Web-to-Host Pro components can be installed automatically using either the MSI Packager or the Service
Manager.

The MSI Packager provides complete local start capabilities. You create custom installations that can be
deployed on restricted-user systems. You can add all of the Pro emulation types, SimXfer tables for AS/400
file transfer, RSS Client security, a VBA-type script engine, localized client Help, and distribution packages.
For more information on MSI Packager, see the online MSI Packager User Guide supplied with the product.

Service Manager is installed on client workstations by a user with administrator rights. Once the Service
Manager has been installed, it downloads and installs all Pro components regardless of user rights. The
rest of this section describes installation using this component.

Note: Web-to-Host Pro 6.9.4 SP2 is compatible with Rumba+ version 10.2 SP2 only. All other Web-to-
Host components work with all versions of Rumba+. For details on co-existence restrictions for the
Pro component and Rumba+ , see Coexistence: Pro and Rumba+ on page 20.

Install procedure with Internet Explorer 11
1. From the browser, run the session HTML created by the Session Configuration Manager. As Web-to-

Host downloads and installs, a progress dialog is displayed.
2. Depending on your browser security settings, the Security Warning dialog box may appear asking if

you want to install the Service Manager. Click Yes to run the install. Once the Service Manager is
installed, all necessary Pro ActiveX controls are installed and the session opens.

Note: There may be instances where a message appears in the browser window telling you to restart
the computer. If it appears, click OK. After restarting, open Internet Explorer, click the extension you
want to connect to, then proceed with your host session.

Install procedure with Google Chrome, Microsoft Edge, or Mozilla
Firefox

1. On the client machine, run nmservicemgr.msi, located on the server machine in \w2hlegacy\pro.

2. From the browser, run the HTML session created by the Session Configuration Manager. 

As Web-to-Host downloads and installs, a progress dialog is displayed.

Silent Install procedure
As mentioned above, the standard Web-to-Host Pro installation displays a progress dialog while
downloading and installing. However, it is possible to run a silent installation. That is, an install and
download with no progress dialog displayed. To do this:

1. Navigate to \w2hlegacy\config\productcfg.xml. This file contains component descriptions and
version numbers.

2. In the <product_info> section, change the silent_install property to true. By default it is set
to false. After editing, silent_install should be:

<silent_install value="true"/>.

3. After making the necessary change to productcfg.xml, follow the standard installation procedure.

Uninstalling the Pro client
1. From the Windows Control Panel, go to Programs and Features, select Micro Focus OnWeb Web-to-

Host Pro Client 6.9.4 SP2, then click Uninstall.
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2. Click OK in the Web-to-Host Pro Client Uninstall message box.
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Coexistence: Pro and Rumba+
Rumba+, a traditional desktop host emulation application that runs on Windows clients, and Web-to-Host
Pro have shared executable files. Consequently, certain conditions must be met for both products to coexist
on the same client workstation.

Web-to-Host Pro 6.9.4 SP2 is compatible with Rumba+ 10.2 SP2.

Coexistence with Rumba+
On the client workstation, the Rumba+ version must be 10.2 SP2. The language and the installation
location of Rumba+ and Web-to-Host Pro client are defined by the product, which is installed first.

If an incompatible version of either Rumba+ or Web-to-Host is installed, an error message appears.

Setting a custom install path
When Web-to-Host installation comes first, and its installation location must be customized, use the MSI
Packager tool located in \utils\MSIPackager. For more information on MSI Packager, see the Help
supplied with the tool.

Upgrading Pro and Rumba+
When you install a new Web-to-Host version or Service Pack, the new Pro software automatically
downloads to the client workstation when the user opens a Pro session. The start-up program compares
the Pro and Rumba+ desktop versions. If the versions are not compatible, the user receives a message.
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User Profile Configuration
There are two types of Pro configuration settings in Web-to-Host:

• Administrator settings - created by Web-to-Host administrators using the Session Configuration
Manager and deployed to the users as HTML session files.

• User settings - stored in a local configuration file (.cph). If the administrator has enabled editing
specific options in the Session Configuration Manager, users create their own customized local
configurations settings for options, such as interface color, toolbars, menus, keyboard map or logon
script.

In some previous versions of Web-to-Host, when the administrator made changes to Pro HTML session
files, all user changes were reset (deleted).

Web-to-Host 6.9.4 SP2 provides a mechanism that preserves user changes. The SCM Wizard changes do
not automatically delete the user's .cph file. Settings which only the user can set are not deleted when
you, the administrator, change the HTML session files. This means users do not lose their customized
environment with its colors, toolbars, and keyboard mappings.

This chapter lists the conditions that determine which configuration file takes precedence, if both an HTML
session files and a user .cph file exist. It also explains how the configuration file is handled when included
within a distribution package.

Rules defining Pro behavior
This section lists the rules for determining the settings implemented - default settings in HTML session files
or user customized .cph settings.

No user configuration (.cph) file exists
The first time the user opens a session no user .cph file exists. Consequently, the user
receives the options defined in the Session Configuration Manager.

Existing user configuration (.cph) file

When a user .cph file exists, the following rules apply:

• If a .cph file exists, but no particular option is enabled, the user receives the default
options set in the Session Configuration Manager. This is because you have not given
the user permission to modify options. For example, if a user .cph file exists but you
did not select Enable Edit Options, the user cannot create a customized configuration
with features, such as word wrap or type ahead. The user is required to use the values
set in the HTML session file.

• If a .cph file exists and a particular option is enabled, the user can customize the
configuration. For example, if Enable Edit Options is selected, the user can create a
personalized environment that allows features, such as word wrap, type ahead, and
keyboard auto reset. In this case, if you make changes to the HTML session file
including those features which the user has customized, the user .cph file is not
deleted and the customized environment remains in effect.

To enforce the use of the default HTML settings, you should disable the relevant option,
for example, Enable Edit Options. Then the HTML settings override user settings for
those options only. All other user configurations remain in effect.
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User configuration files in a distribution package
As an administrator you can create a user .cph file from the session’s HTML configuration and include it in
a distribution package. This means the user starts with a customized, pre-configured session. It also
means that you can provide the user with more configurable client options than you can assign using the
Session Configuration Manager.

You can enable a particular client option, modify its settings using the option dialog, insert the session
configuration file into a distribution package, then optionally disable the option (depending on whether you
want to allow further user editing).

For example, selecting Enable Edit Options in the Session Configuration Manager allows you to open the
Edit Options dialog box within a session and choose clipboard and parsing options that are not part of the
Session Configuration Manager. The additional settings are added to the user .cph file. Then you can
associate the session .cph file to a distribution package. If you want to maintain standardization, you can
disable edit options.

In all cases, if you modify the distribution package, the new user configuration replaces the user’s previous
file, deleting all user settings.
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User Data File Locations
Web-to-Host stores user data on the client in a location specified by the user’s environment. This location
is determined by several environmental variables, such as the client operating system and browser, and
whether roaming user profiles are enabled.

Roaming profile support for Pro sessions
While normal Windows profiles store user environment settings on the client workstation, roaming user
profiles store this information on their server. When a user logs on to the server, the roaming profile is
downloaded to the client workstation. When the user logs off the server, the roaming profile (along with any
changes) is uploaded back to the server. This scenario enables the user to work on different client
workstations while using the same environment settings.

Web-to-Host supports roaming user profiles for Pro sessions. Users with roaming profiles can access their
custom settings (such as keyboard maps and macros) when running Pro sessions on various workstations.

Default paths for user data files
This section lists the user data file locations for Pro client workstations with a default Windows installation
and using Internet Explorer.

If Rumba+ has been previously installed on the client workstation, Web-to-Host stores user data files in the
same location. If not, these locations are read from the Windows registry.

Roaming path:

C:\Users\<user_name>\AppData\Roaming\Micro Focus\Rumba

Local path:

C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba

You can use the MSI Packager to modify default user data file locations. For more information on the MSI
Packager see the online help supplied with the utility.
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Creating a Trace
The Trace utility is a diagnostic tool for troubleshooting host communications and connectivity problems.
With this utility you can trace activity within host software or other standardized components linked to
OnWeb Web-to-Host. This section describes how to use the Trace utility to get a binary trace that can be
sent to Rocket Software for additional help troubleshooting your problems.

Pro uses the Rumba+ Desktop Trace utility that comes with Rumba+ as standard. If Rumba+ is installed,
use its trace utility.

If Rumba+ is not installed, you can download the Trace utility from the server hosting Web-to-Host. Type
the following URL into the address bar of any Web browser.

http://<servername>/w2hlegacy/utils/installrumbatrace.msi

Important: Before starting the procedure, close all applications. If you are using Rumba+, ensure it is
closed.

To take a correct binary trace:

1. If Rumba+ is installed, select Start > All Programs > Micro Focus Rumba+ Desktop > Rumba+
Desktop Tools > Rumba+ Desktop Trace. Otherwise, select Start > All Programs > RUMBA Trace >
RUMBA Trace.

2. On the menu bar, select Options > Configuration.

3. On the API Selection page, click Select All. After all entries have been selected, click Reset All.

4. On the Output page, in the Formatted Output section, select Display.

5. In the Binary Output section select Binary File. The box next to the option becomes available.

6. Enter the full path for the binary file being created (or browse to it). or example, you might assign the file
the call log number, c368758.bin. All file names should end with the extension .bin.

7. Click OK.

8. Minimize the Rumba+ Desktop Trace window that appears.

9. Run the Rumba+ application that is causing the problem as you normally would, starting from the
connection (for example, Rumba+ display, or printer). Let the program run until the problem appears
(error message, session hanging, or any other problem).

10.Log off and disconnect from the host.

11.Maximize the Rumba+ Desktop Trace window, then select File > Exit.

12.Send the .bin file you created by email to Micro Focus Technical Support.
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Notices
Copyright
© 1996-2024 Rocket Software, Inc. or its affiliates. All Rights Reserved.

Trademarks
Rocket is a registered trademark of Rocket Software, Inc. For a list of Rocket registered trademarks go to:
www.rocketsoftware.com/about/legal. All other products or services mentioned in this document may be
covered by the trademarks, service marks, or product names of their respective owners.

Examples
This information might contain examples of data and reports. The examples include the names of
individuals, companies, brands, and products. All of these names are fictitious and any similarity to the
names and addresses used by an actual business enterprise is entirely coincidental.

License agreement
This software and the associated documentation are proprietary and confidential to Rocket Software, Inc.
or its affiliates, are furnished under license, and may be used and copied only in accordance with the terms
of such license.

Note: This product may contain encryption technology. Many countries prohibit or restrict the use, import,
or export of encryption technologies, and current use, import, and export regulations should be followed
when exporting this product.

Corporate information
Rocket Software, Inc. develops enterprise infrastructure products in four key areas: storage, networks, and
compliance; database servers and tools; business information and analytics; and application development,
integration, and modernization. Website: www.rocketsoftware.com

Contacting Technical Support
The Rocket Community is the primary method of obtaining support. If you have current support and
maintenance agreements with Rocket Software, you can access the Rocket Community and report a
problem, download an update, or read answers to FAQs. To log in to the Rocket Community or to request a
Rocket Community account, go to www.rocketsoftware.com/support. In addition to using the Rocket
Community to obtain support, you can use one of the telephone numbers that are listed above or send an
email to support@rocketsoftware.com.

Rocket Global Headquarters
Rocket Global Headquarters
77 4th Avenue, Suite 100
Waltham, MA 02451-1468
USA

Country and Toll-free telephone number
To contact Rocket Software by telephone for any reason, including obtaining pre-sales information and
technical support, use one of the following telephone numbers.

• United States: 1-855-577-4323
• Australia: 1-800-823-405
• Belgium: 0800-266-65
• Canada: 1-855-577-432
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• China: 400-120-9242
• France: 08-05-08-05-62
• Germany: 0800-180-0882
• Italy: 800-878-
• Japan: 0800-170-5464
• Netherlands: 0-800-022-2961
• New Zealand: 0800-003210
• South Africa: 0-800-980-818
• United Kingdom: 0800-520-0439
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ROCKET SOFTWARE END USER LICENSE
AGREEMENT

IMPORTANT: ROCKET SOFTWARE, INC. OR ITS AFFILIATE DESIGNATED IN THE ENTITY TABLE
LOCATED AT www.rocketsoftware.com/company/legal/AMC-assigned-entity ("LICENSOR") PROVIDES
LICENSED SOFTWARE TO LICENSEE (HEREINAFTER "CUSTOMER") UNDER THIS END USER
LICENSE AGREEMENT (THE "AGREEMENT"). THIS AGREEMENT GOVERNS CUSTOMER'S
INSTALLATION AND USE OF THE VERSION OF THE LICENSED SOFTWARE IDENTIFIED IN THE
APPLICABLE PRODUCT ORDER, OR IF NOT ACQUIRED VIA A PRODUCT ORDER, CUSTOMER'S
DOWNLOAD AND INSTALLATION OR USE OF THE LICENSED SOFTWARE CONSTITUTES
ACCEPTANCE OF THIS AGREEMENT. PLEASE READ THIS AGREEMENT CAREFULLY, AS IT
CONTAINS RESTRICTIONS ON CUSTOMER USE OF THE SOFTWARE. THIS AGREEMENT
SUPERSEDES AND CONTROLS OVER ANY OTHER TERMS PROVIDED TO CUSTOMER
REGARDING CUSTOMER'S USE OF THE LICENSED SOFTWARE, WHETHER WRITTEN OR ORAL,
UNLESS A DIFFERENT WRITTEN AGREEMENT IS EXPRESSLY REFERENCED IN A PRODUCT
ORDER OR EXECUTED BY LICENSOR AND CUSTOMER THAT SUPPLEMENTS OR SUPERSEDES
ALL OR PORTIONS OF THIS AGREEMENT. ENTERING INTO THIS AGREEMENT DOES NOT
CONSTITUTE A SALES TRANSACTION.

1. DEFINITIONS. Capitalized terms in this Agreement are defined as follows:

"Additional License Authorization" or "ALA" means the additional specific software license terms
that govern the use of a given software product, including (but not limited to) the provisions of the Non-
Production Licensing Guide. The ALA(s) for Licensed Software are found at https://
www.rocketsoftware.com/company/trust/agreements by product name, or can be provided by Rocket
Software at Customer's request.

"Customer" or "Licensee" means the legal entity or individual that is identified in the applicable Product
Order or who has rightfully received a license to the Licensed Product.

"Documentation" means the user documentation Rocket Software makes available for Licensed
Software.

"Licensed Product" means Licensed Software and Documentation.

"Licensed Software" means the executable version of the software listed in the Product Order or
otherwise provided to or rightfully acquired by Customer. This Agreement will govern the use of any
update to the Licensed Software that Customer receives pursuant to a separate support and
maintenance agreement as described in the Support and Maintenance section below, unless such
update contains, comes with, or is otherwise specifically governed by a different end user license
agreement.

"Open Source Software" means software or other material embedded in or made available with a
Licensed Product where such software or other material is made available under an "open source
license" as this term is commonly understood by members of the open source community, including, but
not limited to, those licenses meeting all the criteria prescribed in the Open Source Definition provided
by the Open Source Initiative (https://opensource.org/osd).

"Product Order" means the combination of a Rocket Software Quote and a purchase order or purchase
order alternative agreed to by the parties for the sale of a license(s) of one or more specific items of
Licensed Software to Customer.

"Rocket Software" or "Licensor" means the applicable Rocket Software entity listed on the Entity
Table.

ROCKET SOFTWARE END USER LICENSE AGREEMENT | 27

https://www.rocketsoftware.com/company/legal/AMC-assigned-entity
https://www.rocketsoftware.com/company/trust/agreements
https://www.rocketsoftware.com/company/trust/agreements
https://opensource.org/osd


"Rocket Software Quote" is a quote issued by Rocket Software or its authorized billing agent which
contains the one or more specific items of Licensed Software, quantity, price and other pertinent license
details.

"Third Party Component" means any third party run time or other elements embedded in Licensed
Software other than Open Source Software.

"Third Party Software" means additional or accompanying third party software (other than Open
Source Software or Third Party Components) that is specified in the Documentation or in a file
accompanying Licensed Software.

"Warranty Period" means the 90-day period starting from the date Licensed Software is delivered to
Customer.

2. PRODUCT ORDERS. The licensing of software products takes place under Product Orders which
(unless stated otherwise in the Product Order) incorporate the terms of this Agreement. Any terms that
conflict or are in addition to the terms of this Agreement or any applicable ALA ("Inconsistent Terms") in
a purchase order or other document issued by Customer are rejected by Rocket Software and have no
force and effect. If there is any Inconsistent Term(s) in a Product Order, such Inconsistent Term(s) shall
not apply except where such Inconsistent Term(s) is contained in a Rocket Software Quote or a Product
Order that is signed by both parties. Open Text Corporation("OpenText") and its affiliates are temporarily
providing quoting and invoicing service for certain Rocket Software products and services and is acting
as a billing agent for Rocket Software until further notice. Rocket Software will provide relevant billing
and payment information as and when the transition to Rocket Software invoicing and billing systems
occurs. Rocket Software is not otherwise affiliated or associated with Micro Focus or OpenText. "Micro
Focus" and "OpenText" are registered trademarks of OpenText or its affiliates.

3. LICENSING.

a. License. Except as specifically permitted in the applicable ALA, or as described in the Evaluation
Licenses section below, Rocket Software and its affiliates, respectively deliver and license to
Customer the Licensed Products under a non-transferable, non-sublicensable, non-exclusive license
to use Licensed Software and its Documentation as set out in this Agreement and/or the applicable
ALA and solely for Customer's internal business operations and not for further distribution or
commercialization.

b. Evaluation Licenses. Except as specifically permitted in the applicable ALA, when Rocket Software
and its affiliates, respectively deliver and license the Licensed Products solely for evaluation,
Customer receives a non-transferable, non-sublicensable, non-exclusive license to use Licensed
Products for internal evaluation and testing purposes only, and not for any development, production,
distribution or commercial purpose ("Evaluation License"). The term of an Evaluation License will
be 30 days starting from the date Licensed Product is delivered (i.e., made available for download or
physically delivered) to Customer ("Evaluation Term"), unless Rocket Software authorizes a
different period in writing. The Licensed Product is provided "as is" and there are no warranties or
obligations for Rocket Software to provide support. The Evaluation License terminates at the end of
the Evaluation Term, and Customer is required to return, or, if Rocket Software so directs, delete and
destroy, all copies of such Licensed Product and provide Rocket Software with written confirmation
of its compliance with this provision within 30 days of the end of the Evaluation Term. The Evaluation
License for any prerelease or beta versions of Licensed Software ("Pre-Release Software") shall be
for a term of 90 days unless Rocket Software authorizes a different period in writing. Customer
agrees to promptly report to Rocket Software all problems (including errors, failures, nonconforming
results, and unexpected performances) and any comments regarding the Pre-Release Software and
to timely respond to all questionnaires submitted by Rocket Software regarding the results of
Customer's testing of the Pre-Release Software. Rocket Software may choose not to release a final
version of the Pre-Release Software or, even if released, to alter prices, features, specifications,
capabilities, functions, release dates, general availability, or other characteristics of the Pre-Release
Software.

4. USE RESTRICTIONS.

a. Except as specifically permitted in the applicable ALA or Documentation, Customer will not, directly
or indirectly:
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a. Use Licensed Software for time-sharing, outsourcing, hosting, service bureau or like use, or
permit access by, or use for the benefit of, any third party;

b. Modify or create derivative works of Licensed Software;
c. Reverse engineer, decrypt, disassemble or otherwise attempt to discover the source code of

Licensed Software, except to the extent permitted by applicable law;
d. Unbundle component parts of Licensed Software for separate use, where Licensed Software with

multiple components is provided to Customer as a single product;
e. Publish or disclose to third parties any evaluation or benchmarking of Licensed Software; or
f. Alter, destroy, or remove any proprietary notices or labels on or embedded in Licensed Software.

b. Customer may make a reasonable number of archival copies of Licensed Software and
Documentation, and will reproduce all copyright and other proprietary rights notices appearing in or
on Licensed Products, including notices of all third party suppliers, on all permitted copies.

5. TERM. This Agreement and the license term for the Licensed Software granted herein is perpetual,
unless a subscription/term license has been purchased by Customer (in which case the license term
shall be set forth in the Product Order or ALA), and is subject to earlier termination as provided in the
Termination section below. If Customer has purchased a subscription/term license, such license shall
automatically terminate upon expiry of such subscription/term, unless earlier terminated in accordance
with this Agreement.

6. TERMINATION. Except as set forth herein, either party may terminate this Agreement, and/or any
license granted, on written notice if the other party materially breaches the terms of this Agreement, or
any applicable ALA or Product Order and does not cure the breach within 30 days of the date such
party is notified of such breach. Rocket Software may terminate this Agreement, along with any or all
licenses then in effect with Customer, immediately by giving Customer written notice of termination in
the event that (i) Customer becomes insolvent, has a receiver appointed, or files for or has filed against
it, liquidation, bankruptcy or analogous proceedings; or (ii) Customer infringes or misappropriates the
intellectual property rights of Rocket Software. Termination shall be without prejudice to any other rights
or remedies a party may have. In the event of any termination, Customer's license(s) to install, access
or use the Licensed Software will immediately terminate, and Customer shall destroy and erase all
copies of such Licensed Software in its possession or control and provide written certification to Rocket
Software that it has complied with this provision. Early termination of this Agreement or any Product
Order will not entitle Customer to any credit or refund or reimbursement of any previously paid fees.

7. SUPPORT AND MAINTENANCE. Customer is not entitled to any updates to Licensed Software, unless
Customer purchases (or may receive under a subscription/term license) maintenance and support
services pursuant to Rocket Software's then current applicable standard maintenance and support
agreement (which is found at https://www.rocketsoftware.com/company/trust/agreements or can be
provided by Rocket Software at Customer's request).

8. HARDWARE. In the event that Rocket Software provides Licensed Software embedded in an appliance,
or provides hardware to Customer for use in conjunction with Licensed Software, additional hardware
terms and conditions will apply. In all other instances, Customer will obtain and install any necessary
hardware for proper installation and implementation of Licensed Software.

9. PROFESSIONAL SERVICES. If Customer has Rocket Software or a Rocket Software affiliate perform
any services with respect to Licensed Software (e.g., installation, implementation, maintenance,
consulting or training), Rocket Software or its affiliate will provide those services at its then current
standard terms and conditions and rates unless otherwise agreed in writing by the parties. Customer
may agree to enter into a professional services engagement with Rocket Software or its affiliate through
a separate agreement or statement of work.

10.LIMITED WARRANTY. Rocket Software warrants for the Warranty Period that the Licensed Software
substantially conforms in all material respects to the Documentation, and any media on which Rocket
Software provides Licensed Software is free from defects in materials and workmanship under normal
use.

Customer's sole and exclusive remedy for breach of such warranty is (i) repair or replacement of the
applicable Licensed Software or media free of charge so that it substantially conforms to Documentation
or (ii) if Rocket Software reasonably determines such remedy is not economically or technically feasible,
a refund of the license fee and any maintenance fee paid for the Licensed Software for the current year.
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The license to use such Licensed Software will immediately terminate when Customer receives the
refund.

The warranties described herein do not apply if the defects in Licensed Software or media result from:
(i) failure to use Licensed Software in accordance with Documentation, this Agreement or the applicable
ALA; (ii) malfunction of Customer's equipment or network; (iii) accident, neglect, or abuse; (iv) service
by any unauthorized person; (v) other software used by Customer not provided by Rocket Software, or
for which Licensed Software is not designed or licensed for such use; or (vi) any other cause occurring
after initial delivery of Licensed Software or media to Customer, unless directly caused by Rocket
Software. For purposes of this Agreement, Licensed Software is deemed delivered when it is first made
available for download by, or physically delivered to, Customer.

Rocket Software has no responsibility for any claims made outside the Warranty Period.

The warranties described herein also apply to Third Party Components, but do not apply to (i) any free-
of-charge Licensed Software or updates provided following the Warranty Period; or (ii) third party
software that is not a Third Party Component.

11.DISCLAIMER OF WARRANTY. Except for the limited warranties herein, Licensed Products are
provided "as is" without warranty of any kind. To the extent permitted by law, all implied or
statutory terms, conditions, representations, and warranties (including without limitation all
terms, conditions, representations and warranties regarding merchantability, quality or fitness
for a particular purpose, title or non-infringement, or that may arise out of course of dealing,
usage or trade practice) are expressly disclaimed and excluded to the extent allowed by
applicable law. The limited warranties in this Agreement are provided on the basis that
Customer is procuring Licensed Products for the purposes of a business and not for household
or consumer use. Rocket Software does not warrant that operation of Licensed Software will be
uninterrupted or error-free. Customer has sole responsibility to select Licensed Software that
works with other software, applications or systems to achieve intended results.

12.LIMITATION OF LIABILITY.

a. Liability Cap. In no event will any liability of one party to the other party arising out of or in
connection with this Agreement exceed the total fees paid by Customer for the affected
Licensed Software in the relevant Product Order(s) (including related maintenance and
support). Nothing in this Section shall limit either party's liability for: willful misconduct or
fraudulent misrepresentation; unauthorized use of intellectual property; breach of license;
death or bodily injury caused by negligence; non-payment of amounts owed; or any liability
which may not be excluded or limited by applicable law.

b. Mutual Disclaimer of Consequential Damages. In no event will either party be liable for any
indirect, special, incidental, consequential, punitive or similar damages; loss of profits,
business, data or programs (including, but not limited to, the cost of recovery or replacement
of such data or programs); loss, damage or any costs due to interruption, delay or inability to
use Licensed Software, whether arising out of or in connection with this Agreement, even if
informed of the possibility of such damages in advance.

c. Scope. The limitations and disclaimers herein apply to all causes of action, including but not limited
to, breach of contract, breach of warranty, negligence, strict liability, misrepresentation and other
torts.

d. Exclusive Remedy. The remedies in this Agreement are the parties' exclusive remedies and the
limitations of the Liability Cap section and the Mutual Disclaimer of Consequential Damages section
apply even if these remedies fail of their essential purpose. Customer may have other rights,
including consumer rights, under the laws of the state or country where it is located.

e. Free-of-Charge Software. If Rocket Software provides Customer with any Licensed Software free-of-
charge or under an Evaluation License, to the extent permitted by law, Rocket Software and its
affiliates will not be responsible for any loss or damage to Customer, its customers, or any third
parties caused by that Licensed Software which is free-of-charge.

13.OWNERSHIP. Rocket Software, Inc. and its affiliates and their suppliers own or have the right to use or
further distribute all intellectual property rights in Licensed Products, and authorize Rocket Software to
distribute Licensed Products under this Agreement. Customer's only rights in Licensed Products are the
express licenses referenced in this Agreement or the applicable ALA.
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14.OPEN SOURCE SOFTWARE AND THIRD PARTY SOFTWARE. Open Source Software and Third
Party Software are governed by the terms of their respective licenses and not the terms of this
Agreement, notwithstanding anything to the contrary in any applicable ALA. Information about the Open
Source Software may be found in a file accompanying the Licensed Software or in the Documentation
or ALA.

15.LICENSE FEES AND PAYMENT TERMS. Customer will pay the license fees set forth in the applicable
Product Order for Licensed Software within 30 days of the date of invoice. Software license fees are
non-refundable, except as provided herein, and will be paid without deduction or tax withholding.
Software License fees are exclusive of any transportation charges, sales, use, value added, and other
applicable taxes and duties, and all such amounts will be paid or reimbursed by Customer. Customer
will be liable for all outstanding past due amounts, which will accrue interest (at the rate of 1.5% per
month compounded or the maximum rate permitted by law if lower) and any collection costs for
recovery of past due amounts.

16.LICENSE VERIFICATION. Rocket Software has the right to verify Customer's compliance with licenses
to the Licensed Software.

Customer agrees to keep records sufficient to show Customer's compliance, including serial numbers;
license keys; logs; records identifying machines on which Licensed Software is installed, accessed, or
from which Licensed Software can be accessed; the number of different users accessing or authorized
to access Licensed Software (if applicable); and licensing metrics, reports, and copies of Licensed
Software. Rocket Software may require Customer to provide information about its deployment of
Licensed Software, which may be in the form of a questionnaire. Customer will have a reasonable time
to complete the questionnaire (or other form of request) and provide it to Rocket Software with an
authorized Customer signatory certifying the accuracy of the information furnished. Upon 10 days prior
written notice, Rocket Software or its designated representative may inspect Customer's records,
systems and facilities, during Customer's normal business hours, to verify compliance with licenses to
the Licensed Software. Customer agrees to cooperate with such verification. Information obtained will
be used solely for compliance purposes and will otherwise be subject to the confidentiality provisions of
this Agreement. If Customer has engaged in unlicensed installation, use of, or access to Licensed
Software or infringed or misappropriated intellectual property rights in Licensed Software, or has
otherwise breached this Agreement or an ALA (a "Non-Compliance"), without prejudice to Rocket
Software' other rights or remedies, including, without limitation, injunctive relief, within thirty (30) days'
notice of such Non-Compliance, Customer agrees to purchase sufficient licenses and or subscriptions
and associated support and maintenance (12 months forward and any applicable back support and
maintenance) to cure the Non-Compliance, by paying Rocket Software's current (as of the date of such
additional purchase) list license fees and support and maintenance fees to Rocket Software, plus
interest (compounded at 1.5% monthly or the maximum rate permitted by applicable law if lower) for
such additional licenses from the commencement of the Non-Compliance until payment of the
aforementioned fees, with interest payable even if an invoice was not issued at the time the Non-
Compliance occurred. If Customer's Non-Compliance results in an underpayment of license fees of 5%
or greater, Customer shall also reimburse Rocket Software for the reasonable cost of such audit in
addition to other amounts due.

17.PRIVACY. Customer is solely responsible for, and assumes all liability with respect to, its own collection,
processing, storage, and transfer of any user data, including personally identifiable information,
personal health and financial information, and other forms of personal information (collectively,
"Personal Information"). Customer is solely responsible for notifying its users of proper use of such
data. Customer is solely responsible for assessing the Licensed Product or any related product or
service for compliance with any industry requirements applicable to Customer. Each party must comply
with its respective obligations under all applicable laws, regulations, and industry standards regarding
data collection and data privacy that apply to use of Licensed Software. Personal information or
customer data that Customer provides to Rocket Software for the purpose of receiving products or
services will be handled in accordance with the Rocket Software Global Data Protection and Privacy
Notice (https://www.rocketsoftware.com/company/legal/privacy-policy) and the privacy and data security
provisions in the applicable ALA.

18.USE OF CUSTOMER INFORMATION. To the extent permitted by law, Customer expressly consents to
the collection and use of information about Customer's purchase, installation and use of Licensed
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Software and the computer systems on which it is installed or accessed as necessary to fulfill the
Product Order and provide the Licensed Product, for security and licensing purposes and to improve
Rocket Software products and services.

19.CUSTOMER FEEDBACK. Customer agrees that, should it provide Rocket Software with any feedback
or suggestions regarding Licensed Products ("Feedback"), Rocket Software and its affiliates will be free
to use all such Feedback, including (but not limited to) all intellectual property rights in and to such
Feedback, in their discretion and for any purpose, without obligation of any kind to Customer.

20.CONFIDENTIAL INFORMATION. Information exchanged under or in connection with this Agreement,
including all information pertaining to Pre-Release Software, will be treated as confidential if identified
as confidential at time of disclosure, or if the circumstances of disclosure reasonably indicate such
information should be treated as confidential. Confidential information may only be used for the purpose
of fulfilling obligations or exercising rights under or in connection with this Agreement, and shared with
employees, affiliates, agents or contractors with a need to know such information to support that
purpose, who are contractually bound to protect its confidentiality. Confidential information will be
protected using a reasonable degree of care to prevent unauthorized use or disclosure for three years
from date of receipt. These obligations do not cover information that (i) was known or becomes known
to the receiving party without a duty of confidentiality; (ii) is independently developed by the receiving
party; (iii) becomes publicly available without breach of this Agreement; (iv) is disclosed with the
disclosing party's prior written consent; or (v) where disclosure is required by law, a court or government
agency. Should the receiving party be required to reveal confidential information under subpoena, court
order or other operation of law, the receiving party will provide reasonable prior notice to the disclosing
party and request a protective order, if available.

21.INDEMNIFICATION FOR INTELLECTUAL PROPERTY RIGHTS INFRINGEMENT. Rocket Software
will defend and/or settle any claims against Customer that Licensed Products furnished under this
Agreement infringe a third party's patent, copyright, or trade secret rights. existing under the laws of a
country where Customer is using the Licensed Product ("IP Infringement Claim"), provided: (i)
Customer promptly notifies Rocket Software in writing of the IP Infringement Claim; (ii) Rocket Software
has sole control of the defense and all related settlement negotiations; and (iii) Customer reasonably
cooperates with Rocket Software in the defense of the IP Infringement Claim.

Rocket Software will pay all damages, costs, and expenses finally awarded (or agreed to by settlement)
for any such IP Infringement Claim. Rocket Software will pay all reasonable out-of-pocket costs incurred
by Customer for cooperation in the defense of the IP Infringement Claim. If, however, Customer wants
separate legal representation, Customer will be responsible for the costs and fees of its separate
counsel.

Should any Licensed Products provided under this Agreement become or, in Rocket Software's opinion,
likely become, the subject of an IP Infringement Claim, Rocket Software may replace or modify affected
Licensed Product so as to make it non-infringing and materially equivalent, or procure for Customer the
right to continue using it. If neither alternative is reasonably available, once Customer has returned or
destroyed all copies of the affected Licensed Product, Rocket Software will refund to Customer the full
amount paid for affected Licensed Product less straight line depreciation on a five-year basis from date
of delivery.

Rocket Software is not responsible for unauthorized use of Licensed Products, and has no obligations
under this Section (Indemnification for Intellectual Property Rights Infringement), to the extent
infringement results from (i) compliance with Customer's designs or instructions, (ii) a modification not
authorized in writing by an authorized Rocket Software signatory, (iii) use or combination with software,
equipment, or data not provided by Rocket Software, (iv) non-licensed use; or (v) Third Party Software
or Open Source Software.

22.MISCELLANEOUS.

a. Assignment. Rocket Software may assign this Agreement and any Product Orders to an affiliate or a
third party in connection with an asset sale or divestiture. Customer may not assign or transfer this
Agreement (or any Product Orders) or any of its rights or duties hereunder, including (but not limited
to) by operation of law, without Rocket Software's prior written consent, which will not be
unreasonably withheld, and payment of any applicable assignment or transfer fee. Any transaction or
series of related transactions resulting in a change in the ownership of more than 50% of the voting
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equity of Customer will be deemed an assignment for purposes of this provision. Any attempted
assignment of this Agreement (or a Product Order) not in accordance with this section (Assignment)
will be null and void.

b. Governing Law and Jurisdiction. This Agreement and, subject to the Open Source Software and
Third Party Software Section, licenses purchased under applicable Product Orders, as well as any
claims or causes of action, whether in contract, tort or statute, based on, arising under or relating to
this Agreement, will be governed and enforced as follows: If Customer's applicable place of business
is located in North America, all matters arising out of or relating to this Agreement are governed by
the laws of the state of Delaware, U.S.A. If Customer is located in the United Kingdom, Australia,
Brazil, France, Germany, Italy, Japan, the Netherlands, New Zealand, Spain or Singapore, all matters
arising out of or relating to this Agreement are governed by the laws of the country in which Licensee
is located. In the rest of the world, the laws of England and Wales govern all matters arising out of or
relating to this Agreement. The applicable law shall apply without regard to conflicts of law
provisions, and without regard to the United Nations Convention on the International Sale of Goods.
Any suit, action, or proceeding arising out of or relating to this Agreement shall be subject to the
exclusive jurisdiction of the courts of the country determining the applicable law, except that the
courts of the State of Delaware shall have exclusive jurisdiction in North America, and Rocket
Software will be allowed to apply for injunctive relief in any jurisdiction. Each party agrees to be
subject to the above-described jurisdiction and waives any right it may have to object to such venue,
including objections based on personal jurisdiction or inconvenient forum. The prevailing party in any
proceeding has the right to recover costs and reasonable attorneys' fees as awarded by the court or
arbitrator.

c. Export Control. Rocket Software and Customer will comply with their respective responsibilities as
exporters and importers under laws and regulations applicable to the export, import or other transfer
of the software, services and technology provided by Rocket Software under this Agreement,
including the export, import and sanctions laws of the United States and other applicable
jurisdictions. If Customer exports, imports, or otherwise transfers any Licensed Products provided
under or in connection with this Agreement (or any technical data related thereto), Customer is
responsible for obtaining any required authorizations. Customer will not use Licensed Products for
any purpose prohibited by applicable export laws, including nuclear, chemical, missile or biological
weapons-related end uses. With respect to any Pre-Release Software provided to Customer,
Customer represents and warrants that(i)it is a non-governmental entity,(ii) the Pre-Release Software
will only be used for internal testing and evaluation, and will not be rented, leased, sold, sublicensed,
assigned, or otherwise transferred, and that it will not transfer or export any product, process, or
service that is the direct product of the Pre-Release Software, and (iii) it will only use the Pre-
Release Software in the United States or the countries listed in Title 15, U.S. CFR Supplement No. 3
to Part 740 - License Exception ENC Favorable Treatment Countries. Customer agrees to indemnify
and hold Rocket Software harmless from and against any damages, claims, losses, fines,
settlements, attorneys' fees, legal fees and court costs and other expenses related to any such
activities or any claims in connection with any breach of this Section.

d. Survival. Rights and obligations of the parties in the following Sections: Use Restrictions, Term,
Termination, Disclaimer of Warranty, Limitation of Liability, Ownership, Open Source Software and
Third Party Software, License Fees and Payment Terms, License Verification, Privacy, Use of
Customer Information, Customer Feedback, Confidential Information, Indemnification for Intellectual
Property Rights Infringement, and Miscellaneous will survive termination or expiration of this
Agreement. Neither party will be liable for delays or non-performance beyond its reasonable control
except for payment obligations.

e. Notices. All notices permitted or required under this Agreement will be in writing and delivered
personally, by courier, telecopy, first class mail, electronic mail, or similar transmission to the other
party. Notices to Rocket Software shall be addressed to: Legal Department, Rocket Software via
email to legal@rocketsoftware.com. Notices to Customer may be sent via electronic mail to any
email address set forth in the Product Order or to its address listed on the applicable Product Order,
or at such other address as may be supplied in writing. The date of delivery or the date of mailing will
be the date of notice.

f. Resellers. Rocket Software's obligations with respect to products or services supplied by Rocket
Software and procured by Customer from an authorized Rocket Software reseller are limited to the
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terms and conditions in this Agreement and the Documentation included with the Rocket Software
supplied products and services. With purchases from a reseller, the applicable pricing and payment
terms are as set out in the separate agreement between Customer and the reseller, and any terms
in this Agreement related to Rocket Software pricing and payments shall not apply. Rocket Software
is not responsible for the acts or omissions of the reseller, or for any other products or services that it
supplies to Customer.

g. Entire Agreement. This Agreement and the applicable Product Order(s) and ALA(s) represent the
entire understanding of the parties with respect to the subject matter of this Agreement and
supersede any previous communications or agreements that may exist regarding the same subject
matter.

h. Order of Precedence. Subject to the Product Orders section, any conflicting terms and conditions will
be resolved according to the following order of precedence: the applicable Product Order, the
applicable ALA, and this Agreement.

i. Amendment. No modification of this Agreement will be binding on the parties unless in writing signed
by authorized representatives of Rocket Software and Customer.

j. Waiver. No waiver of any right under or in connection with this Agreement will be effective unless in
writing, signed by authorized representatives of both parties. No waiver of any past or present right
arising from any breach or failure to perform will be deemed to be a waiver of any future right arising
under or in connection with this Agreement.

k. Publicity. For the term of this Agreement, Rocket Software may use Customer's name in press
releases, product brochures, and other marketing materials to indicate they are Rocket's customer.
Rocket will use Customer's trademarks, service marks, logos or branding, according to any branding
guidelines which Customer makes available to Rocket Software. Licensee hereby agrees to serve as
a reference for the Product(s) at times to be mutually agreed upon. Such references may, as
mutually agreed upon, include activities such as (i) reference calls with or hosting of a site visit with
mutually acceptable prospects; (ii) a published "News Release" announcing the successful
partnership with Rocket no later than sixty (60) days from the date of this Agreement; (iii) mention of
Licensee or Licensee logo on Rocket Software's website; (iv) the completion of a "Case Study;" or
(v) sharing Licensee's "Success Story" which may include speaking at Rocket Software events. Both
parties will agree to the content and timing of any announcement focused on their relationship prior
to distribution.

l. Severability. If any provision in this Agreement or the applicable ALA(s) or Product Order(s) is held
invalid or unenforceable, that provision will be construed, limited, modified or, if necessary, severed,
to the extent necessary, to eliminate its invalidity or unenforceability, and the other provisions will
remain unaffected.
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